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 Цель работы: получение практических навыков работы со статистическим пакетом MINITAB и проведения расчетов в программе MS Exel при расчете и анализе основных статистических показателей.

1. [bookmark: _Toc184224501]Основные характеристики распределения экономических величин

[bookmark: _Toc184224502]Исходным материалом любого статистического исследования  являются совокупность результатов наблюдений. В простейших  случаях они представляют собой выборочные (полученные  в результате наблюдений) значения некоторой случайной величины  X. В задачах статистики распределение  этой случайной величины зачастую неизвестно. 

	Пусть есть N наблюдений некоторой величины X ().Основными статистическими параметрами данной величины являются следующие.
1. 
Среднее значение 


Среднее показывает "центральное положение" (центр) переменной и рассматривается совместно с доверительным интерваломM:\Моя Библиотека\books\Statistika\glossary\gloss_d.html - Confidence Interval. Обычно интерес представляют статистики (например, среднее), дающие информацию о генеральной совокупности в целом. Чем больше размер выборки, тем более надежна оценка среднего. Чем больше изменчивость данных (больше разброс), тем оценка менее надежна.
2. Среднеквадратическое (стандартное) отклонение:


Стандартное отклонение - это широко используемая мера разброса или вариабельности (изменчивости) данных. Среднеквадратическое отклонение показывает средний разброс данных относительно своего среднего значения.
3. Медиана   - это значение, которое разбивает выборку на две равные части. Половина наблюдений лежит ниже медианы, и половина наблюдений лежит выше медианы. Медиана вычисляется следующим образом. Изучаемая выборка упорядочивается в порядке возрастания. Получаемая последовательность ak, где k=1,..., 2*m+1называется вариационным рядом или порядковыми статистиками. Если число наблюдений нечетно, то медиана оценивается как: am+1. Если число наблюдений четно, то медиана оценивается как:


	m=
	am+am+1

	
	2


4. Усеченное среднее. При расчете среднего значения возможно исключение крайних точек из распределения значений переменной. Например, можно исключить (удалить) 5% наименьших и 5% наибольших значений. Среднее значение, рассчитанное для усеченного таким образом распределения, будет называться "усеченным средним" (этот термин впервые был использован Тьюки в 1962г.).
5. Квартили. Нижняя и верхняя квартили (термин был впервые использован Галтоном, 1882; также их называют квантилями 0.25 и 0.75) равны соответственно 25-й и 75-й процентилям распределения. 25-я процентиль переменной - это такое значение, ниже которого попадают 25% значений переменной. Аналогично, 75-я процентиль - это такое значение, ниже которого попадают 75% значений переменной.
6.  Доверительный интервал для среднего задает область вокруг среднего, в которой с заданным уровнем доверия (точностью) содержится "истинное" среднее генеральной совокупности. Например, если среднее в вашей выборке равно 23, а нижняя и верхняя границы для p=.05 равны 19 и 27 соответственно, то вы можете заключить, что с  95% вероятностью среднее выборки больше 19 и меньше 27. Если вы установите меньшее значение p-уровня, то интервал будет шире, и увеличится "уверенность" в оценке, и наоборот; как мы знаем из прогнозов погоды, чем "неопределеннее" прогноз (т.е. шире доверительный интервал), тем скорее он сбудется. Заметим, что ширина доверительного интервала зависит от размера выборки и дисперсии наблюдений. Вычисление доверительных интервалов основывается на предположении, что переменная в совокупности нормально распределена. Эта оценка может быть неверной, если это предположение не выполнено, и пока размер выборки мал, например, n меньше 100.
7. [bookmark: Pearson_Correlation]Корреляция Пирсона. Наиболее часто используемый коэффициент корреляции Пирсона r  называется также линейной корреляцией, т.к. измеряет степень линейных связей между переменными. Можно сказать, что корреляция определяет степень, с которой значения двух переменных пропорциональны друг другу. Важно, что значение коэффициента корреляции не зависит от масштаба измерения. Например, корреляция между ростом и весом будет одной и той же, независимо от того, проводились измерения в дюймах и фунтах или в сантиметрах и килограммах. Пропорциональность означает просто линейную зависимость. Корреляция высокая, если на графике зависимость можно представить прямой линией (с положительным или отрицательным углом наклона). Проведенная прямая называется прямой регрессии или прямой, построенной методом наименьших квадратов. Последний термин связан с тем, что сумма квадратов расстояний (вычисленная по оси Y) от наблюдаемых точек до прямой является минимальной из всех возможных. Заметим, что использование квадратов расстояний приводит к тому, что на оценки параметров сильно влияют выбросы. Корреляция Пирсона предполагает, что две рассматриваемые переменные измерены, по крайней мере, в интервальной шкале. Коэффициент корреляции Пирсона вычисляется следующим образом:


Коэффициент корреляции изменяется в диапазоне от -1 до +1. Чем больше по модулю коэффициент, тем сильнее связь между изучаемыми переменными. Например, между ценой и спросом на товар в случае высокой эластичности спроса будет наблюдаться сильная отрицательная корреляция:

Коэффициент корреляции -1
А между ценой на товар и предложением его на рынке будет наблюдаться сильная корреляция.

Коэффициент корреляции – 1
В случае, если связи между переменными нет, коэффициент корреляции будет стремиться к нулю.

 Коэффициент корреляции – 0,22
8. Таблица частот (Гистограмма). Гистограмма позволяет наглядно оценить частоты попадания случайной величины в определенные интервалы значений. 
[bookmark: _Toc184224503]
2. Общие сведения о пакете MINITAB. Расчет статистических характеристик величин с помощью MINITAB

Статистический пакет MINITAB был разработан в Пенсильванском государственном университете для облегчения  изучения различных статистических дисциплин. Сейчас MINITAB используется более чем в 2000 учебных заведений во всем мире. Более 75 % компаний, входящих в, так называемые Top 50 (по данным журнала Fortune), используют данный пакет в своей работе. 
В нашем университете при изучении дисциплин, связанных с обработкой статистической информации, используются несколько версий статистического пакета MINITAB:
- The Student Edition of MINITAB for Windows;
- Minitab Release 10;
- Minitab Release 12.
Первая из этих трех версий существенно отличается от двух других и имеет большое количество особенностей. Поэтому в дальнейшем при описании возможностей статистического пакета MINITAB эти особенности будут отдельно оговариваться.  The Student Edition of MINITAB for Windows - это учебная версия статистического пакета MINITAB, разработанная для студентов, изучающих различные экономико-математические дисциплины.  
[bookmark: _Toc184224504]2.1 Основные понятия
Рабочий лист – это первичный и основной документ для ввода, анализа и вычисления данных. Он содержит около 3500 ячеек и 1000 колонок.
Ячейка – единичный адресуемый элемент в рабочем листе, которая может содержать значение переменной. Ячейка определяется своим адресом, который состоит из имени столбца и номера строки.
Существует три типа ячеек в MINITAB:
- числовые;
- текстовые;
- ячейки даты/времени.
Числовые данные могут содержать следующие символы: любую последовательность цифр (0,1,2,3,4,5,6,7,8,9), которые могут быть положительными и отрицательными, содержать десятичную и экспоненциальную части. Экспоненциальная запись данных выглядит следующим образом: число 3200 в ячейке может быть представлено в виде 32Е2 или 3.2Е3, что означает - 32 x 102 или 3.2 x 103.
Числовые колонки могут содержать знак - "*".  "Звездочка" означает, что при вводе было пропущено одно из значений, либо она возникла как результат неправильного выполненного или невозможного арифметического действия.  При наличии "*" в колонках с данными некоторые виды расчетов (например, дисперсионный и регрессионный анализы, вычисление коэффициента корреляции и некоторые другие расчеты) MINITAB не производит.
Текстовые данные должны отвечать следующим требованиям:
-  быть не длиннее 80 символов;
- могут содержать внутри себя любые символы (буквы, цифры, знаки пунктуации, пробелы);
- текстовые данные могут сохраняться в колонках, в строках, но не в матрицах.
 Данные представлены в виде даты/времени могут быть нескольких форматов:
	Формат
	Описание
	Пример

	m/d/yy
	Американский формат
	1/5/96

	m-d-yy
	Месяц, день, год
	1-5-96

	d.m.yy
	Европейский формат
	5.1.96

	d-mmm-yy
	Интернацион. формат
	5-Jan-96

	mmm-yy
	Месяц и год
	Jan-96

	h:mm:ss.ss
	24 часовое время
	23:10:14.22

	h:mm:ss.ss AM/PM
	12 часовое время
	11:10:14.22 PM



В более поздних версиях MINITAB (Release 10,  Release 12) имеется возможность перевода данных из одного формата в другой. В зависимости от того, в каком формате нужно представить данные, необходимо выполнить одну из следующих операций:  Manip > Change Data Type > (Numeric to Text, Text to Numeric, Date/Time to Numeric…).   
При необходимости имеется возможность наименования колонок. Это выполняется следующим образом: необходимо активизировать ячейку, расположенную ниже нумерации колонки и ввести в эту ячейку требуемое название. Название колонки может содержать как буквы, так и цифры. В версии "The Student Edition of MINITAB for Windows" название колонки должно быть только на английском языке и содержать не более 8 знаков. 
На рисунке 1 показано, какими могут быть названия колонок и какие существуют форматы представления данных в статистическом пакете MINITAB. MINITAB автоматически распознает соответствующие форматы данных и добавляет к нумерации колонки буквы, обозначающие тот или иной формат. Например, колонка С1 на рисунке 1 содержит данные формата даты/времени и поэтому к названию колонки добавляется буква "D" (C1-D),  аналогично колонка С2 обозначается (С2-Т), т.к. она содержит текстовые данные.
В версии "The Student Edition of MINITAB for Windows"  появление в названии колонки буквы "T" означает, что все данные, которые в ней находятся, будут восприняты как текстовые.
Удаление данных в статистическом пакете MINITAB возможно  следующими способами:
- если требуется удалить ячейки со сдвигом вверх, то  нужно выполнить Edit > Cut Cells;
- если требуется очистить ячейки, то Edit > Clear Cells или нажать на кнопку "Backspace";
- если требуется удалить ячейки, то Edit > Delete Cells или нажать на кнопку "Delete".

Рисунок 1.1 - Возможности представления данных в MINITAB.

Имеется также возможность переставлять колонки местами и менять их ширину.
В более поздних версиях MINITAB (Release 10,  Release 12) имеется возможность работы с матрицами, для этого необходимо выполнить следующую операцию: Calc > Matrices.
 MINITAB включает в себя следующие блоки:
· всесторонние статистические возможности, включая описательную статистику, моделирование и вероятностные распределения, элементарную статистику, дисперсионный и регрессионный анализы, непараметрическую статистику и анализ временных рядов;
· легко доступный интерфейс, позволяющий осуществлять всевозможный анализ статистических данных;
· ячейки пакета MINITAB позволяют вводить, редактировать, просматривать данные на открытом рабочем листе;
· текущий (on-line) Help, который  помогает студенту быстро решить возникающие проблемы;
· имеется возможность импорта и экспорта данных из других программных пакетов, включая Excel;
· совместимость с Lotus 1-2-3;
· профессиональную графику, которая дает возможность пользователю самостоятельно выбирать вид графика;
· похожий интерфейс, команды и устройства ввода-вывода, как и в DOS и Macintosh.

[bookmark: _Toc184224505]2.2	Структура окон в статистическом пакете MINITAB

Статистический пакет MINITAB состоит из следующих основных окон:
· окно данных (Data Window);
· окно результатов (Session Window);
· информационное окно (Info Window);
· окно записи использованных команд (History  Window); 
· графическое окно (Graph Window);
· окно для помощи (Help Window).

Рисунок 2.1  - Внешний вид основного окна MINITAB. 

ОКНО ДАННЫХ (DATA WINDOW): автоматически появляется на экран при запуске MINITAB. Оно представляет собой крупноформатную таблицу, состоящую из ячеек, имеющих каждая свое имя. В ячейку можно вводить данные, а также просматривать и редактировать их.
ОКНО РЕЗУЛЬТАТОВ (SESSION WINDOW):в данном окне выводятся результаты, полученные при расчетах или причины, по которым программа не может выполнить расчеты (ошибки).


Рисунок 2.2 – Внешний вид окна данных (Data Window).


Рисунок 2.3 – Внешний вид окна результатов (Session Window). 

ОКНО ЗАПИСИ ИСПОЛЬЗОВАННЫХ КОМАНД (HISTORY  WINDOW): в данном окне автоматически записываются все команды, которые были использованы во время работы пользователя.
ИНФОРМАЦИОННОЕ ОКНО (INFO WINDOW): в данном окне содержится суммарная информация о количестве используемых колонок и о количестве используемых в них данных, а также сообщает о наличии ошибок в данных.


Рисунок 2.4 – Внешний вид окна записи использованных команд (History  Window). 

Рисунок 2.5 – Внешний вид информационного окна (Info Window); 

ГРАФИЧЕСКОЕ ОКНО (GRAPH WINDOW): в этом окне строятся все графики. Оно выводится на экран автоматически при желании пользователя построить график. Графических окно может быть одновременно несколько  штук. Пользователь может выбрать одно из графических окон, которое будет отображаться на весь дисплей или выбрать, чтобы все графические окна были выведены на дисплей одновременно.

Рисунок 2.6 – Внешний вид графического окна (Graph Window). 
Рисунок 2.7 – Внешний вид окна для помощи (Help Window). 
ОКНО ДЛЯ ПОМОЩИ (HELP WINDOW): в этом окне можно узнать, как правильно пользоваться статистическим пакетом MINITAB, при возникновении различных затруднений у пользователя. В этом окне разрешает копировать и вырезать из текста фрагменты, а также непосредственно распечатывать их на принтере.  
Для удобства пользования некоторыми из перечисленных выше окон, существует возможность быстрого переключения на них с помощью следующих комбинации клавиш:
Ctrl-D     -       окно данных (Data Window);
Ctrl-M    -        окно результатов (Session Window);
Ctrl-I       -        информационное окно (Info Window);
Ctrl-H     -       окно для записи использованных команд (History Window);
 
[bookmark: _Toc184224506]2.3.	Структура меню в статистическом пакете MINITAB

Статистический пакет MINITAB (Здесь описывается структура меню  наиболее простой версии - The Student Edition of MINITAB for Windows. Более поздние версии MINITAB содержат такое же меню, но имеют ещё некоторые дополнительные команды) имеет следующую структуру командного меню:
· файловое меню (File Menu);
· меню редактирования (Edit Menu);
· меню манипуляции (Manip Menu);
· меню для выполнения расчетов (Calc Menu);
· статистическое меню (Stat Menu);
· меню работы с окнами (Window Menu);
· графическое меню (Graph Menu);
· меню редактора (Editor Menu);
· вспомогательное меню (Help Menu). 

КОМАНДЫ ФАЙЛОВОГО МЕНЮ (File Menu) позволяют осуществить следующие операции:
· создать, открыть, сохранить и вернуть рабочий файл;
· импортировать и экспортировать тексты;
· произвести запись содержания окна результатов (Session Window);
· вести работу с макро-файлами;
· сохранять содержимое рабочего файла в отдельный файл с новым именем;
· установить настройку принтера и осуществить формат документа;
· распечатать содержимое любого окна или текстового файла;
· перезапустить и выйти из MINITAB.

КОМАНДЫ МЕНЮ РЕДАКТИРОВАНИЯ (Edit Menu) позволяют осуществить следующие операции:
· отменить результат своего предыдущего действия;
· удалять, копировать, вырезать и выделять необходимые ячейки в рабочем окне;
· возвращать на дисплей последнее диалоговое меню, для его редактирования;
· установить и сохранить настройки размера окон, место и порядок их расположения.

КОМАНДЫ МЕНЮ МАНИПУЛЯЦИИ (Manip Menu) позволяют осуществить следующие операции:
· сортировать и ранжировать ряды данных;
· удалять рядами данных;
· стирать данные из ряда;
· копировать колонки;
· кодировать числовые данные;
· объединять и преобразовывать данные в колонках.

КОМАНДЫ МЕНЮ ДЛЯ ВЫПОЛНЕНИЯ РАСЧЕТОВ (Calc Menu) позволяют осуществить следующие операции:
· генерировать и работать со случайными числами;
· рассчитывать статистику рядов и колонок данных;
· задавать автоматическое заполнение данными колонок (например, последовательностью чисел 1, 2,  3,  4...)
· создавать индикаторы или фиктивные переменные
· стандартизировать данные.
 КОМАНДЫ СТАТИСТИЧЕСКОГО МЕНЮ (Stat Menu) позволяют осуществить следующие операции:
· рассчитать описательную статистику, осуществить линейный регрессионный анализ и дисперсионный анализ;
· выполнить анализ временного ряда, перекрестный анализ и осуществить различные непараметрические тесты.
КОМАНДЫ МЕНЮ РАБОТЫ С ОКНАМИ  (Window Menu) позволяют осуществить следующие операции:
· осуществлять замену активных окон и икон меню;
· работать с графическими окнами;
· переходить из одного окна в другое.
КОМАНДЫ ГРАФИЧЕСКОГО МЕНЮ (Graph Menu) позволяют осуществить следующие операции:
· выводить на дисплей различные графики, включая диаграммы, графики, гистограммы, точечные графики и графики анализа временных рядов;
· устанавливать и сохранять настройки графиков.
КОМАНДЫ МЕНЮ РЕДАКТОРА (Editor Menu) позволяют осуществить следующие операции:
· передвигаться по рабочему окну с данными в любую ячейку;
· форматировать колонки и устанавливать необходимую длину колонок;
· добавлять ряды и колонки;
· редактировать данные в ячейке.
КОМАНДЫ ВСПОМОГАТЕЛЬНОГО МЕНЮ (Help Menu) позволяют осуществить следующие операции:
· выводить на экран систему помощи, состоящей из следующих разделов: содержание, начало работы с MINITAB, раздел «Как мне сделать...» и описание как пользоваться вспомогательным меню MINITAB;
· ознакомиться с информацией о Вашей версии MINITAB.
После того как Вы завершить работу в статистическом пакете MINITAB необходимо для закрытия программы выполнить следующие команды: File > Exit.

[bookmark: _Toc184224507]2.4. Расчет основных статистик в пакете Minitab.

В ходе выполнения лабораторной работы студент должен получить практические навыки и умения по следующим пунктам:
· открывать и исследовать уже существующие файлы. Вводить новую информацию, создавать файлы;
· вносить новые изменения в эти файлы, с помощью арифметических функций, для уже существующих данных;
· описывать характер используемых переменных, используя основы статистики;
· сортировать и ранжировать данные;
· создавать графики на основе данных рабочего файла;
· рассчитать коэффициент корреляции двух величин из рабочего файла;
· завершение работы в статистическом пакете MINITAB.    

1. Открытие и исследование уже существующего файла.  Чтобы открыть файл Pay.mtv, который находится на диске С:\Mtbsew\Student9,  необходимо выбрать на панели меню следующую комбинацию команд: File > Open Worksheet > Select File. Найти с левой стороны файл Pay.mtv и дважды щелкнуть по нему мышкой. На экране появится окно со следующими данными (Рис. 4.1):
В колонках С1-С8 отражены следующие данные:
С1 – заработная плата сотрудников компании “Technitron”;
С2 – срок работы сотрудников в данной компании;
С3 – опыт предыдущей работы в других компаниях;
С4 – срок обучения после школы;
С5 – возраст сотрудника;
С6 – индитификационный  код сотрудника;
С7 – пол сотрудника (выраженный в буквах (М – мужской, F - женский));
С8 – пол сотрудника (выраженный в цифрах (0 – мужской, 1 - женский)).
Рисунок 4.1 – Внешний вид окна данных, в котором открыт файл Pay.mtv
2. Если необходимо получить новый столбец, каждый элемент которого содержал бы сумму (разницу, произведение) двух других, то Осуществление арифметических операций над данными в колонках.
Для этого необходимо выполнить следующие действия: Calc > Calculator На экране появится следующее диалоговое окно:
Рисунок 4.5 - Внешний вид окна Mathematical Expressions. 
Если необходимо получить трудовой стаж сотрудников, то нужно сложить данные столбцов С2 и С3 (срок работы в компании “Technitron” и срок предыдущей работы в других компаниях). Для этого необходимо указать название колонки, в которой будет храниться результат этого сложения и в прямоугольнике «Выражения» (Expression) указать название колонок, которые будут суммироваться, а также знак суммы «+». В результате этих действий будет получена ещё одна колонка, в которой будет результат суммирования.

3. Получение описательной статистики данных, находящихся в одной колонке. Для этого необходимо выполнить следующие действия: Stat > Basic Statistics  > Descriptive Statistics. На экране появится следующее диалоговое окно, которое изображено на рис 4.4. Для получения данных описательной статистики необходимо указать название колонки с данными, например, колонка С1-(SALARY). В результате выполнение данной операции в окне результатов (Session Window) появится следующие данные:
                          N     MEAN   MEDIAN   TRMEAN    STDEV   SEMEAN
SALARY       10     33831      32224      33959           5679         1796

                       MIN      MAX        Q1        Q3
SALARY      24749    41889    29396    39196
где N – количество данных в столбце SALARY
MEAN – среднее значение;
MEDIAN – значение медианы;
STDEV – среднеквадратическое отклонение;
    MIN и MAX – минимальное и максимальное значение заработной платы (SALARY). 
Рисунок 4.4 – Внешний вид окна Descriptive Statistics.
6. Расчет коэффициента корреляции. Для этого необходимо выполнить следующие действия: Stat > Basic Statistics  > Correlation. На экране появится следующее диалоговое окно:

Рисунок 4.6 - Внешний вид окна Correlation.
Для получения коэффициента корреляции между величиной заработной платы и возрастом сотрудника необходимо указать в окне «Переменные» (Variables) колонки С1 и С5. В результате выполнение данной операции в окне результатов (Session Window) появится следующие данные:

Correlation of SALARY and AGE = 0.886

2. Получение суммарной статистики по столбцу
Для получения суммарного показателя по столбцу (суммы, среднего) и т.д. необходимо зайти Calc > Column statistics и заполнить диалоговое окно, как это показано на рисунке 4.7


Рисунок 4.7. – Диалоговое окно статистики по столбцам
3. Ранжирование данных. Осуществляется следующим образом: Manip > Rank. На экране появится окно, которое показано на рис. 4.3. Для ранжирования данных необходимо указать следующие характеристики: название колонки, которая будет ранжирована (для этого необходимо дважды щелкнуть мышкой по названию колонки, расположенной на экране с левой стороны) и название колонки, в которой будут храниться ранги колонки.

Рисунок 4.3 – Внешний вид окна Rank.


7. Построение графиков. Для построения графиков необходимо выполнить следующие действия: Graph > (Plot, Chart, Histogram, Boxplot, Time Series Plot). После выбора команды Graph необходимо выбрать один из типов графиков, которые перечислены в скобках. Если выбрали Plot, то в результате на экране появится диалоговое  окно, которое показано на рисунке 4.7.
Необходимо указать какая из колонок будет являться X, а какая Y. После этого нажать OK или клавишу «Enter». На экране появится график, изображенный на рисунке 4.8.

Рисунок 4.7 – Внешний вид диалогового окна Plot.
 
Рисунок 4.8 – График, полученный при построении в режиме Plot.



8. Завершение работы в статистическом пакете MINITAB. После завершение выполнения лабораторной работы, чтобы выйти из статистического пакета MINITAB необходимо выполнить следующую операцию: File > Exit, или нажать на квадратик с крестиком в правом верхнем углу монитора. В результате выполнения любого из этих действий на мониторе появятся два следующих окна:


Рисунок 4.9 - Окна MINITAB, появляющиеся при выходе из статистического пакета.

Если в ходе выполнения лабораторной работы вы использовали файл с базы данных, встроенной в MINITAB, то необходимо оба раза выбрать ответ "Нет", так как в противном случае вы можете испортить базу данных. Если же в ходе лабораторной работы вы использовали ваш файл, то вы можете записать его на винчестер.
 
4. Задание по выполнению лабораторной работы

1. Ввести данные в соответствии в вариантом лабораторной работы
2. Получить суммарный объем продаж всех магазинов помесячно.
3. Получить и проанализировать описательную статистику по всем магазинам и суммарному значению.
4. Построить корреляционную матрицу по объемам продаж между магазинами. Определить коэффициент корреляции между месяцем и суммарным объемом продаж. Сделать вывод о тенденции изменения суммарного объема реализации.
5. Получить величину общего объема продаж во всех магазинах за год и по каждому магазину
6. Построить гистограмму для совокупного объема продаж. Проанализировать полученные данные.
7. Построить график совокупного объема продаж.
8. Получить ранги для совокупного объема продаж. Проанализировать полученные данные.
9.  Выполнить действия 1-8 в MS Exel.
[bookmark: _Toc184224509]
5. Варианты заданий по выполнению лабораторной работы

Сеть магазинов розничной торговли  продуктами питания имеет отчетность по выручке магазинов за год помесячно. Необходимо в соответствии с вариантом задания проанализировать выручку магазинов: получить описательную статистику по магазинам, получить суммарную выручку, найти коэффициент корреляции между показателями выручки магазинов, построить гистограмму по суммарной выручке и графики по выручке магазинов.
Таблица 1. – Выручка от реализации продукции по сети магазинов, тыс. грн.
	 
	магазин

	месяц
	M1
	M2
	M3
	M4
	M5
	M6
	M7
	M8

	1
	6
	13
	17
	8
	15
	9
	13
	46

	2
	10
	11
	13
	6
	10
	11
	15
	21

	3
	16
	25
	15
	10
	12
	10
	23
	30

	4
	16
	19
	14
	6
	11
	14
	20
	25

	5
	17
	31
	11
	10
	9
	15
	32
	17

	6
	35
	35
	14
	6
	13
	13
	18
	15

	7
	25
	37
	8
	11
	15
	21
	31
	14

	8
	43
	41
	6
	7
	14
	24
	33
	17

	9
	32
	58
	8
	6
	10
	20
	37
	13

	10
	48
	69
	5
	9
	13
	17
	38
	8

	11
	50
	88
	5
	11
	17
	25
	44
	6

	12
	52
	54
	4
	9
	10
	21
	32
	2



Таблица 2. – Варианты заданий по выполнению лабораторной работы.
	Вариант
	номер магазина

	1
	M1
	M2
	M3
	M4

	2
	M2
	M3
	M4
	M5

	3
	M3
	M4
	M5
	M6

	4
	M4
	M5
	M6
	M7

	5
	M5
	M6
	M7
	M8

	6
	M1
	M3
	M4
	M5

	7
	M1
	M4
	M5
	M6

	8
	M1
	M5
	M6
	M7

	9
	M1
	M6
	M7
	M8

	10
	M1
	M3
	M5
	M7

	11
	M2
	M4
	M5
	M6

	12
	M2
	M5
	M6
	M7

	13
	M2
	M6
	M7
	M8

	14
	M2
	M4
	M6
	M8

	15
	M2
	M5
	M7
	M8



 6.Контрольные вопросы

1. Перечислите основные статистические характеристики.
2. Что показывает среднеквадратическое отклонение?  
3. Что такое медиана?
4. Как рассчитывается усеченное среднее?
5. Что показывают квартили?
6. Что такое доверительный интервал?
7. Что показывает величина коэффициента корреляции?
8. Что такое гистограмма?
9. Какие действия позволяет выполнять пакет Minitab?
10. Что означает символ  "*", который находится в колонке с данными?
11. Какие виды окон существуют в пакете Minitab?
12. Каким образом  осуществляется ранжирование и сортировка данных в пакете Minitab?
13. Каким образом осуществляется получение описательной статистики для данных, находящихся в колонках пакета Minitab?
14. Каким образом осуществляется построение графиков в пакете Minitab?
15. Каким образом осуществляется получение коэффициента корреляции в пакете Minitab?
16. С какими еще программными пакетами совместим пакет Minitab?
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